Contents

1. Copyright Notice..................................................................................................................3

2. What is the Print Control Wizard?.....................................................................................5
   2.1. How Does it Work?.........................................................................................................5

3. What is a Printing Condition?.............................................................................................6
   3.1. Curves for Controlling Dot Gain..................................................................................6
       3.1.1. What is Dot Gain?.................................................................................................6
       3.1.2. What is Dot Gain Compensation?.......................................................................7
       3.1.3. Dot Gain Compensation Curves..........................................................................8
       3.1.4. PressSync Curves...............................................................................................8
   3.2. Screens for Controlling Ink Lay Down.......................................................................10
       3.2.1. What is Screening?.............................................................................................10
       3.2.2. Types of Screens...............................................................................................12
   3.3. Using a Printing Condition in Your Production Workflow........................................15

4. Installing the Print Control Wizard...................................................................................17
   4.1. Installation with a Remote Database............................................................................17
   4.2. Upgrade with a Remote Database..............................................................................18

5. Creating a Printing Condition...........................................................................................20
   5.1. Collecting Your Production Settings..........................................................................21
       5.1.1. Press Settings.....................................................................................................22
       5.1.2. Substrate Settings..............................................................................................22
       5.1.3. Imager Settings..................................................................................................23
       5.1.4. Exposure Settings..............................................................................................24
       5.1.5. Plate Settings.....................................................................................................24
       5.1.6. Printing Standard...............................................................................................25
       5.1.7. Ink Set................................................................................................................27
       5.1.8. Ink Settings.........................................................................................................27
       5.1.9. Anilox Settings....................................................................................................28
       5.1.10. Mounting Tape Settings....................................................................................28
   5.2. Linearizing Your Separations.......................................................................................29
       5.2.1. Making and Analyzing a Print Sample...............................................................29
       5.2.2. Handling the Remaining Separations...............................................................46
   5.3. Resulting Screens and Curves......................................................................................47

6. Using Your Printing Condition in Imaging Engine..........................................................48

7. Managing Your Printing Conditions..................................................................................49
   7.1. Printing Condition States............................................................................................50
   7.2. Importing and Exporting Printing Conditions............................................................51
1. Copyright Notice

© Copyright 2019 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. What is the Print Control Wizard?

The Print Control Wizard is an application designed to help you optimize your print quality. Based on your exact production workflow, your current print quality and the standard you want to print towards, the Print Control Wizard will calculate the best possible screens and curves that you can use to achieve great results on press.

This will help you avoid common problems, for example a lack of smoothness in the transition from highlights to paper, or from shadows to solids, and will make getting good printing quality time after time easier.

2.1. How Does it Work?

The Print Control Wizard will help you achieve the best possible printing quality in the following way:

1. Record all the production settings you are using.
   In the first few steps of the Print Control Wizard, you enter all of the settings you use in your production workflow (anilox, plate type, consumables... including the standard you want to print towards).
   See Collecting Your Production Settings on page 21.

2. Fingerprint your press using the Print Control Wizard.
   a) The Print Control Wizard will guide you in making and interpreting a print sample using one of the inks you print with.
      Based on your input and the results of the print sample, it gives you the best curve and screen to use for that ink.
   b) You can either use that screen and curve for your other inks too, or make a sample for each of your printing inks (to get individual curves and screens per ink).
   See Linearizing Your Separations on page 29.

3. The Print Control Wizard generates a printing condition containing curve(s) and screen(s) tailored to your production workflow.
   See What is a Printing Condition? on page 6.

4. You use that printing condition when RIP'ing your jobs with Imaging Engine to get great results on press.
   See Using a Printing Condition in Your Production Workflow on page 15.
3. What is a Printing Condition?

The Print Control Wizard will guide you in creating a printing condition. This printing condition will:

• describe your exact production workflow (plate-making workflow and printing setup) and the way it prints,
• include the standard you want to print towards (an ISO standard, linear printing...),
• result in the best possible curves and screens to achieve the quality of that standard with your production workflow.

**Important:**

After making a printing condition, you should use it every time you print with that production workflow.

If you make changes to your production workflow (for example you print on a different substrate, or you switch to a different ink vendor), we recommend you make a new printing condition and use that instead.

3.1. Curves for Controlling Dot Gain

3.1.1. What is Dot Gain?

When printing a job, the dots tend to print larger on the press than on the plate, which makes the output darker than the original file.

<table>
<thead>
<tr>
<th>Original job</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Plate</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Plate Image]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Print Image]</td>
</tr>
</tbody>
</table>
This is due to different factors:

- the type of ink: the more fluid the ink is, the more it will spread under pressure of the press.
- the type of substrate: paper with a rougher and more porous surface (like uncoated paper) reflects less light, making the printed area look darker.
- the type of press: flexo presses have a high dot gain as they put significant pressure on the substrate.

### 3.1.2. What is Dot Gain Compensation?

To compensate for dot gain and have the printed output look like the original file, you use **dot gain compensation (DGC)**. This consists in making the dots on the plate smaller, so that with dot gain they print to the correct density.

<table>
<thead>
<tr>
<th></th>
<th>Dot on plate</th>
<th>Dot on press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Without DGC</td>
<td><img src="image" alt="Dot on plate (No DGC)" /></td>
<td><img src="image" alt="Dot on press (No DGC)" /></td>
</tr>
<tr>
<td>With DGC</td>
<td><img src="image" alt="Dot on plate (With DGC)" /></td>
<td><img src="image" alt="Dot on press (With DGC)" /></td>
</tr>
</tbody>
</table>

You apply dot gain compensation by using a curve, which can be:

- a classic dot gain compensation curve (also called **DGC curve**), which defines which percentage to use on plate for each desired percentage on press.
  
  See *Dot Gain Compensation Curves* on page 8.

- a **PressSync curve**: PressSync curves are predefined compensation curves that can cover the dot gain compensation needs of most presses, while significantly reducing the complexity of dot gain compensation in workflows.
  
  See *PressSync Curves* on page 8.

The Print Control Wizard generates **flexible PressSync curves**, that contain additional parameters to address specific flexo printing challenges in the highlights and shadows.

See *Flexible PressSync Curves* on page 9.
3.1.3. Dot Gain Compensation Curves

Traditionally, you apply dot gain compensation by using a dot gain compensation curve, which defines which percentage to use on plate for each desired percentage on press.

In the example below, you see how a press prints without any dot gain compensation in the dot gain curve at left: a 20% density on the plate prints to 57% on press. 57% on the plate would print to almost 90% on press.

At right, you see the dot gain compensation curve used to make the press print to the densities expected in the job: to print a 57% density on press, a 20% density will be used on the plate. To print a 20% density on press, you would need a density of about 5% on the plate.

Creating a Dot Gain Compensation Curve

You can create dot gain compensation curves in Curve Pilot (see the Curve Pilot documentation for more information).

Dot gain compensation curve files have the .dgc extension.

3.1.4. PressSync Curves

Another type of compensation curve is the PressSync curve.

PressSync curves are predefined compensation curves that can cover the dot gain compensation needs of most presses, while significantly reducing the complexity of dot gain compensation in workflows.

Slope and Mid-tone Compensation

Curves are defined by a letter and a number.

- The letter (A to H) describes how the press behaves in the highlights and shadows (the slope): an A curve makes the press print darker in the highlights and lighter in the shadows
(for presses who have the opposite problem), while an H curve, on the contrary, makes the press print lighter in the highlights and darker in the shadows.

An E curve is halfway in between and has a straight slope: it corrects the output the same way throughout the range. Use it for presses whose output is consistent in the highlights, mid-tones and shadows.

- The number indicates how much the 50% dot (mid-tone) prints to: an E20 curve compensates the 50% dot to 20%, while an E70 curve compensates 50% to 70%.

Creating a PressSync Curve
You cannot create PressSync curves, they are predefined. There are 400 different PressSync curves, to match most dot gain compensation needs.

If you wish, you can see each PressSync curve on a graph in PressSync Pilot (see the Curve Pilot/PressSync Pilot documentation for more information).

Flexible PressSync Curves
A flexible PressSync curve is a specific type of PressSync curve made for managing the tone reproduction of flexo printing environments.

On top of the letter and number defining the standard PressSync curves, a flexible PressSync curve contains options to address specific flexo printing challenges.
Reproducing Highlights

Flexo highlights are often too sharp against the substrate and/or unstable, which can be difficult to adjust using standard PressSync curves:

- For some ink/substrate combinations, the contrast between the substrate and the lightest printed tone is high: even a very small halftone dot leaves a strong ink impression.
- On top of that, very small dots often don't print in a stable way on flexible substrates, so the minimum dot size is increased to get stable highlights.

Flexible PressSync curves contain parameters to address those highlight issues.

Reproducing Shadows

The most common issue with shadows in flexo is tone reversal, where a high percentage (for example 95%) prints darker than the solid (100%).

Surface screening effects (special screen patterns used in the solid areas to improve ink lay-down and avoid tone reversal) are often used in offset, but not always available for, or compatible with, a flexo printing environment.

Flexible PressSync curves also contain parameters to address tone reversal issues in the shadows.

You can find more information about flexible PressSync curves parameters in the Curve Pilot documentation.

Note: Adjustment curves generated by the Print Control Wizard are flexible PressSync curves.

3.2. Screens for Controlling Ink Lay Down

3.2.1. What is Screening?

When printing an image on press, each ink (Cyan, Magenta, Yellow, Black and any additional ink) is laid out separately on the substrate, and the super-imposition gives the final colors.

At a high detail level, the press can either print ink or not print ink, so to create differences of color intensity within one ink, you use a small scale pattern of dots of varying size, called a screen.
When viewed from a regular distance, this pattern looks like a lighter or darker shade of that color, depending on how big the dots are (what percentage of the area they cover).

Screen Ruling

The screen can also be coarser or finer, so that you have to be more or less far away to see it as shades of a color. This depends on how many lines of dots can fit in a certain measurement. This is expressed in lines per inch (lpi), lines per centimeter (lp/cm) or lines per millimeter (lp/mm), and is called the *screen ruling*.

A low screen ruling as below left looks very coarse, and the quality improves as the screen ruling gets higher.
3.2.2. Types of Screens

The Print Control Wizard will generate a custom screen for your production workflow, so that you get the best possible printed results.

You can choose to either:

• fingerprint your workflow with one separation, generate a screen, and use that screen for your other separations too,
• do the fingerprinting and screen generation process for every separation you are using (this is the most accurate option but is also more time consuming).

The Print Control Wizard generates your custom screen(s) using the dot shapes that work best with your flexo printing application. See:

• Screens for Flexibles on page 12
• Screens for Labels on page 14

Screens for Flexibles

Crystal Screens

When working with flexibles, the custom screens that the Print Control Wizard generates for you are Crystal or Crystal C screens.

The Crystal screens family are Esko’s latest screening technology, developed exclusively for use with the CDI Crystal imager series and the XPS Crystal exposure unit series, for a high quality flexo printing workflow.

Screen Characteristics

Crystal/Crystal C screens use multiple Esko screening technologies:

• Pixel+ technology, where each dot is made of individual pixels, that are "boosted" on the CDI to make printable dots,
• FM screening in the highlights (used in your custom screen when it benefits your particular production workflow),
• support dots at single or double ruling (used in your custom screen when it benefits your particular production workflow).

**Crystal** screens use the Pixel+ technology throughout the tonal range.

**Crystal C** screens use solid dots in the highlights, and transition to Pixel+ dots for the rest of the tonal range.

Crystal C screens can produce finer highlights, but Crystal screens can be more stable. The optimal screen to use depends on your particular production workflow.

When using Crystal/Crystal C screens, you don't need to use object-based screening (different screens for individual objects in your file), as they give good results in all areas:

• They provide a smooth transition from the solids into the shadows and mid-tones, with reduced dot bridging.

  dot bridging with a circular dot  no dot bridging with a crystal screen

• They produce stable highlights that fade out to zero more smoothly than with other screening technologies.
Screens for Labels

When working with labels, the Print Control Wizard generates custom screens based on the dot shapes proven to work the best for labels work.

**Note:**

In the Print Control Wizard, the names of the screens generated using classic dot shapes start with **Crystal NP**.

This stands for "Non Pixel+", as these screens are not specifically designed for working with the CDI Crystal imager series and the XPS Crystal exposure unit series devices.

You can choose between:

**Circular (short name: C)**

Circular dots grow continuously circular until 100%. They are commonly used in flexography.

This dot shape is also called **Circular (Euclidean)**, and Print Control Wizard screens using this dot shape are called **Crystal NP C (Circular)**.

This dot gives good results in many situations. However in some printing conditions the holes in the shadows can fill in, which can result in unstable or high dot gain, and cause a loss in tonal range.

If you experience this, you should choose the **Round Fogra** dot instead.

**Elliptical (short name: E)**

This dot shape is a more elliptical version of the **Round Fogra** dot.

For these dots, the first touching point is around 35%. Between 35% and 65%, a chain is formed with the same orientations as for the Round Fogra dots.

Print Control Wizard screens using this dot shape are called **Crystal NP E (Elliptical)**.

**Double Circular (short name: F)**

Screens using the Double Circular dot have circular dots in the highlights and mid-tones, and circular holes in the shadows.
Print Control Wizard screens using this dot shape are called **Crystal NP F (Double Circular)**. Note that this screen can cause irregular ink bridging ("bridges" between dots) around the mid-tones, which can give unstable dot gain in that tonal range.

If you experience this, you should choose the **Round Fogra** dot instead.

**Round Fogra (short name: R)**

The Round Fogra dot closely resembles the **Elliptical** and **Circular** dots, and can be used the same way.

It goes from a round dot to a round hole, with a square/diamond shape in the mid-tones.

As with elliptical dots, the touching of the dots at the four corners at 50% (leading to a 50% intensity jump) is avoided by using a more elongated dot shape so that the dots first touch around 45% forming a chain and touching for the second time around 55%. This causes less artefacts and less dot gain when printing.

The Round Fogra dot can be used for virtually all printing processes.

Print Control Wizard screens using this dot shape are called **Crystal NP R (Round Fogra)**.

**Crystal**

You can also use Crystal/Crystal C screens when working with labels. See **Crystal Screens** for more information.

### 3.3. Using a Printing Condition in Your Production Workflow

1. After prepress, you send your ready-to-RIP files to Imaging Engine.
2. In Imaging Engine, you select the *printing condition* you made with the Print Control Wizard.

   See **Using Your Printing Condition in Imaging Engine** on page 48 for details.
3. After RIP'ing your files, it's time for Flexo Plate Making, using either:
   • automated plate making in Automation Engine,
   • manual plate making using Grapholas or the Digital Flexo Suite.

   **Note:** When working with version 18.0.1 or later of Imaging Engine and the Print Control Wizard and preparing your plates manually, you need version 18.1 or later of Grapholas or the Digital Flexo Suite software.

For more information, see the "CDI Workflow" chapter of your Automation Engine manual, or your Grapholas/Digital Flexo Suite documentation.

4. You image and expose your flexo plate using the devices and settings you entered in the Print Control Wizard.

   See:
   • *Plate Settings* on page 24,
   • *Imager Settings* on page 23,
   • *Exposure Settings* on page 24.

5. You print your files on your press using the hardware and consumables you entered in the Print Control Wizard.

   See:
   • *Press Settings* on page 22,
   • *Substrate Settings* on page 22,
   • *Ink Set* on page 27,
   • *Ink Settings* on page 27,
   • *Anilox Settings* on page 28,
   • *Mounting Tape Settings* on page 28.
## 4. Installing the Print Control Wizard

The Print Control Wizard software includes two components:

- **The Print Control Wizard tool** itself: this is installed as part of the Imaging Engine Installation DVD.
  
  Please see the Imaging Engine Installation Guide (located on your installation DVD) for details.

- **The Printing Conditions database**, where your printing conditions are saved: this is installed as part of the Automation Engine Installation DVD.
  
  Please see the Automation Engine Installation Guide for details.

**Note:** Always install Automation Engine first and then Imaging Engine.

### Installing the Print Control Wizard in a Distributed Automation Engine Setup

If you are working with separate servers for Automation Engine and your SQL Server, you need to create the **Printing Conditions database** on your database server, and connect your Automation Engine server to it.

See:

- *Installation with a Remote Database* on page 17
- *Upgrade with a Remote Database* on page 18

### 4.1. Installation with a Remote Database

If you want to work in a distributed Automation Engine setup (you have a separate server with an SQL Server database, where you want your **Printing Conditions database** to be), you need to do the following:

1. **Install Automation Engine using the Automation Engine Master for use with an existing Microsoft SQL Server** option.
   
   See the Automation Engine Installation Guide for details.

2. **Use Automation Engine’s Server Admin tool to create the Printing Conditions database** on your remote SQL Server.
   
   a) In a web browser, go to `http://servername:9999/` or `http://servername`, where *servername* is the name of your Automation Engine host server.
   
   b) If you are asked to either create an administrator account or to log in with an administrator account, do so.
   
   c) On the Server Admin page, you see the **Create Automation Engine Databases** dialog.
   
   d) Select your remote SQL Server and its database Instance.
Print Control Wizard

Tip:

- If the SQL Server you want to use is not in the list, click Select another SQL Server and enter your SQL server name.

- If the instances running on your SQL Server cannot be detected (because the SQL Server Browser is not running on that server, for example), enter the port number corresponding to the instance you want to use in the Instance field.

e) Enter a User name and Password with sufficient privileges. Typically this is the sa user.
f) Fill in the (local) path to the Database folder on your SQL Server. This is where the Automation Engine databases will be created.
g) Click Create to start automatically creating the Automation Engine databases (including the Printing Conditions database).
h) After the database creation is complete, the Automation Engine server will be restarted automatically.

3. Install Imaging Engine.
See the Imaging Engine Installation Guide for details.

4.2. Upgrade with a Remote Database

If you want to upgrade a distributed Automation Engine setup (and to have the Printing Conditions database on your remote SQL Server), you need to do the following:

1. Upgrade Automation Engine using the Automation Engine Master for use with an existing Microsoft SQL Server option.
See the Automation Engine Installation Guide for details.

2. Use Automation Engine's Server Admin tool to create the Printing Conditions database on your remote SQL Server.

   a) In a web browser, go to http://servername:9999/ or http://servername, where servername is the name of your Automation Engine host server.
b) Click Server Admin and log in with an administrator account.
c) Click Databases at left.
d) Check that:
   - your remote SQL Server and the correct database Instance are selected,

   Tip: If the instances running on your SQL Server cannot be detected (because the SQL Server Browser is not running on that server, for example), enter the port number corresponding to the instance you want to use in the Instance field.

   - the instance is running (click ⌁ to refresh the status).

e) Click the lock at the bottom of the page and log in to your SQL Server instance using a User name and Password with sufficient privileges (typically the sa user).
f) Click at the bottom of the Databases table.
g) In the **Create Database** dialog:

- Enter **PrintingConditions** in **Database Name**.
- In **Use Data**, select **No (empty database)**.
- Click **OK**.

**Note:** Alternatively, you can create the database using SQL Server Management Studio.

### 3. Use Automation Engine’s **Configure** tool to connect to the **Printing Conditions database** on your remote database server.

a) In the Automation Engine Pilot, go to **Tools > Configure**.

b) Click **Automation Engine Database** then **Printing Conditions**.

c) Check that the **Database** field contains **PrintingConditions** and that the **DBMS Type** is set to **Microsoft SQL Server**.

d) Enter the name of your remote database server in **Host**.  
   If you needed to **fill in a port for your instance**, enter this port after : next to **Host**.

e) Enter the **User** and **Password** you use to **connect to your database**.

f) Click **Test Connection**.  
   You should see a message that your **Database** is online and accessible.

g) Click **Apply**.

h) Go to **File > Save** (or press **Ctrl + S**) before closing the **Configure** tool.

### 4. Restart your Automation Engine server.

### 5. Upgrade Imaging Engine.

   See the Imaging Engine Installation Guide for details.
5. Creating a Printing Condition

1. Double-click the **Print Control Wizard** icon on your desktop.

2. Click at the bottom of the **Print Control Wizard** window to start creating a printing condition.

   You can also delete an existing printing condition, edit it, or duplicate it. See **Managing Your Printing Conditions** on page 49 for more details.

   This opens the **Create Printing Condition** wizard, that will guide you through entering the relevant settings and making a print sample to assess your production workflow's output.

3. In the wizard's first step:
   a) Enter the **Printing Condition Name** you want to use.
      We recommend you use a descriptive name, that includes some of your workflow's key settings, for example Press Type - Plate Type - Substrate Type.
   b) Select the **Application** of your flexo printing workflow (the type of jobs and substrates that you usually work on).

   **Note:** Depending on your license, you may see one or more options here.

   - Select **Flexibles** if you are printing on flexible packaging.
   - Select **Labels** if you are printing labels (on a narrow web substrate).

   The printing condition you make will be adapted to your flexo printing application. The Print Control Wizard will later generate a test chart whose design and size are adapted to the application you select here, and guide you in making and analyzing a print sample using that test chart.

   c) If desired, enter a **Description** for future reference (with for example more information about your production workflow, your name, the date on which you are making your printing condition...).

   **Tip:**
   - If at some point in the wizard you want to stop working on your printing condition and continue later, click **Save and Quit**.
     When you are ready to continue working on it, select it in the **Print Control Wizard** window and click .
   - Some wizard steps contain additional explanations, in grey panels with blue titles, or when you click on **Read more...** links.

4. Enter all the relevant settings of your production workflow in the next few wizard steps.
   See **Collecting Your Production Settings** on page 21.

5. Linearize your separations by making and analyzing one or more prints sample.
   See **Linearizing Your Separations** on page 29.
6. The Print Control Wizard finds the best screens and curves for your production workflow. See *Resulting Screens and Curves* on page 47.

### 5.1. Collecting Your Production Settings

In your production workflow, many settings (related to your **Press**, **Substrate**, **Imager**, **Exposure** and **Plate**) affect how your output is printed. Therefore these settings are important for determining the best curves and screens for your workflow.

For best results, make sure that you:

1. enter the exact settings you are using in your production workflow,
2. use these same settings when making a print sample,
3. once you have made a **printing condition** for those production settings, keep using that printing condition when working with those production settings.

**Note:**

If you change some of your production settings (for example you use a different substrate), you will need to make a different printing condition to reflect this.

To do this, you can duplicate your original printing condition and change for example the substrate before making a new print sample. This way you don’t need to re-enter all your production settings in the wizard.

1. In the **Collect Settings - Specify Your Press and Substrate** step:
   
   a) Enter your press settings.
   
   b) Enter your substrate settings.

2. In the **Collect Settings - Define Imager and Plate Settings** step:
   
   a) Enter your imager settings.
   
   b) Enter your exposure settings.
   
   c) Enter your plate settings.

3. In the **Collect Settings - Select Printing Standard** step, choose the printing standard that you want to match.

   See *Printing Standard* on page 25.

4. In the **Collect Settings - Select Ink Set** step, select the ink set you are printing with.

   See *Ink Set* on page 27.

5. In the **Collect Settings - Define Ink Properties** step, enter more information about the inks you are printing with.

   See *Ink Settings* on page 27.

6. In the **Collect Settings - Define Anilox Properties** step, enter information about the anilox you are using for each ink.

   See *Anilox Settings* on page 28.

7. In the **Collect Settings - Define Mounting Tape Properties** step, enter information about the tape you are using to affix your plate to the plate cylinder on your press.
5.1.1. Press Settings

In the wizard's **Collect Settings - Specify Your Press and Substrate** step, enter a few settings about your press (get more information from your press room if needed).

1. Enter your **Press Brand**.
2. Select your **Press Type**. It can be either:
   - a **Central Impression** press (containing a single large-diameter common impression cylinder that supports the substrate as it enters in contact with a series of adjacent plate cylinders).
   - an **In-line Press** (in which the substrate passes through multiple color stations which are aligned in a straight horizontal line).
   - a **Stack Press** (in which the substrate passes through multiple color stations which are aligned in one or two vertical stacks).
3. If desired, enter additional press information to help guide your press operator during press setup and print tests:
   - your press' **Printing Speed** in meters per minute,
   - its **Cylinder Width** in millimeters,
   - the **Anilox to Plate Impression** in pounds per square inch (this is the minimum pressure required to produce a proper ink transfer from anilox to plate - also called "kiss impression" or "kiss pressure"),
   - the **Plate to Substrate Impression** in pounds per square inch (the minimum pressure required to produce a proper ink transfer from plate to substrate).

You can enter up to two decimals (using . as a decimal separator).

5.1.2. Substrate Settings

In the wizard's **Collect Settings - Specify Your Press and Substrate** step, enter your substrate settings.

1. Select your **Substrate Type**. It can be:
   - **Acrylic** (a substrate made of acrylicate, polyacrylate or methyl methacrylate components, sold for example under the Perspex, Plexiglas, Lucite or Acrylite trade names),
   - **Paper**,
   - **PE** (a polyethylene, polyester, PET, PETG or HPDE substrate, sold for example under the Mylar, Melinex, Hostaphan or BoPET trade names),
   - **PP** (a polypropylene, PVC or vinyl substrate),
   - **PS** (polystyrene),
   - **Spun PE** (spun and bonded polyethylene, sold for example under the Tyvek trade name).
2. Add a **Description** of your substrate if desired (for example if you are routinely working with several substrates of the same type).

3. Select your substrate's **Opacity**.
   - Clear
   - Opaque
   - Transparent
   - **White Overprint** (where a white ink is printed on top of the other inks, for example for reverse printing)
   - **White Underprint** (where a white ink is printed under the other inks)

4. Enter your substrate's **Thickness** in microns.

### 5.1.3. Imager Settings

In the wizard's **Collect Settings - Define Imager and Plate Settings** step, enter your imager settings.

1. Select your **Imager Type**. You can make a printing condition for a production workflow using either:
   - a **CDI Crystal** (the new generation of Esko imager, using the Crystal technology),
   - a **CDI Spark** (an older generation of Esko imager).

   See [CDI Imagers](#) for information about Esko's different CDI models.

2. Select the **Optics** technology contained in your CDI.

   **Tip:** If you don't know your CDI's optics technology, you can find it in the tables below (it is linked to its maximum imaging speed).

#### Table: CDI Spark (Models 2530, 4835, 4260 and 5080)

<table>
<thead>
<tr>
<th>Maximum Imaging Speed</th>
<th>Optics Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5 m²/hr</td>
<td>Optics 15</td>
</tr>
<tr>
<td>2.5 m²/hr</td>
<td>Optics 25</td>
</tr>
<tr>
<td>4 m²/hr</td>
<td>Optics 40</td>
</tr>
<tr>
<td>8 m²/hr</td>
<td><strong>Optics 80</strong> or <strong>Optics 80 v2</strong> (depending on the model)</td>
</tr>
</tbody>
</table>

#### Table: CDI Crystal (Models 4835 and 5080)

<table>
<thead>
<tr>
<th>Maximum Imaging Speed</th>
<th>Optics Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 m²/hr</td>
<td><strong>Optics 40 v2</strong></td>
</tr>
<tr>
<td>8 m²/hr</td>
<td><strong>Optics 80 v2</strong></td>
</tr>
</tbody>
</table>
3. Enter your CDI's **Resolution** in pixels per inch.
   In a lot of cases this will be 4000 ppi.

4. Enter the level of **Pixel Boost** that you normally use with this CDI and *plate type*.
   This indicates how much energy the CDI's laser should use to "boost" single pixels for better printability. The higher the number you enter here, the more the laser will enlarge single pixels on the plate.
   See your CDI documentation for more information about choosing a level of pixel boost.

### 5.1.4. Exposure Settings

In the wizard's **Collect Settings - Define Imager and Plate Settings** step, enter some settings about your exposure device.

1. In **Exposure Type**, select the type of exposure device you are working with.
   The choices available depend on your *flexo printing application* and your license:
   - If you are working with flexibles, this can be:
     - an **External** (non-Esko) exposure device (this can be an analog or digital device),
     - an **Inline-UV** device (that exposes the front of the plate directly after imaging),
     - an **XPS** Crystal device (that exposes the front and back of the plate at once using UV LEDs).
   - When working with labels, the Print Control Wizard workflow is optimized for working with **XPS** exposure devices.

   **Tip:**
   You can combine the **CDI Crystal 5080** imager and the **XPS Crystal 5080** exposure device into a **CDI Crystal 5080 XPS** setup for simplified, highly efficient plate creation.
   See **CDI Crystal 5080 XPS** for more information.

   **Note:** The Print Control Wizard will later generate a test chart (for you to make a print sample) optimized for your flexo printing application and your type of exposure device.

2. Add a **Description** if desired (especially if you own several exposure devices of the same type).

### 5.1.5. Plate Settings

In the wizard's **Collect Settings - Define Imager and Plate Settings** step, enter your plate settings.

1. Select your **Plate Type**.
   For more flexibility, the Print Control Wizard supports many plate types from different manufacturers. You can select a plate type from:
• Asahi
• Dantex
• Dupont
• Flint
• MacDermid

2. Select your plate's Thickness (in millimeters).

3. Enter your plate's Relief Depth (in millimeters).
   This is the depth of the dots on your plate (or the difference in height between the printing surface and the floor of the plate).
   You can calculate your plate relief depth (in red below) by measuring your plate's thickness (in blue) and subtracting the plate floor's thickness (in green).

4. Optionally, you can enter your plate's Hardness level on the Shore A hardness scale.
   You can measure your plate's hardness using a durometer. The Shore A scale is used for softer polymers, elastomers, and rubbers.

5. Select the Developer you use for your plate (to remove the parts of the polymer plate that were not hardened by the exposure):
   • Dupont-fast
   • Solvent
   • Water

5.1.6. Printing Standard

In the wizard's Collect Settings - Select Printing Standard step, define how you want your printing setup to print.

You do this by choosing a Printing Standard that you want to match. The printing standard defines:
• the expected color of the substrate and inks,
• target dot gain curves for each printing ink,
• how to measure tone values.

When you make a print sample, the wizard will analyze whether its dot gain matches the one defined in your chosen standard.

If it doesn't, the wizard will generate dot gain curves to correct that dot gain and bring it in line with the standard, and include them in your printing condition.

1. Select your desired Printing Standard from a list of predefined PressSync curve set templates.
It can be:

- a curve set based on the ISO 12647 standards family:
  
<table>
<thead>
<tr>
<th>cmyk_Equinox</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmyk_FOGRA51</td>
</tr>
<tr>
<td>cmyk_FOGRA52</td>
</tr>
<tr>
<td>cmyk_ISO_Newsprint</td>
</tr>
<tr>
<td>cmyk_ISO_PT1&amp;2 (NP)</td>
</tr>
<tr>
<td>cmyk_ISO_PT1&amp;2</td>
</tr>
<tr>
<td>cmyk_ISO_PT3</td>
</tr>
<tr>
<td>cmyk_ISO_PT4</td>
</tr>
<tr>
<td>cmyk_ISO_PT5</td>
</tr>
<tr>
<td>cmyk_ISO_Web</td>
</tr>
</tbody>
</table>

See the *PressSync Templates Based on the ISO 12647 Standards* in the Curve Pilot documentation for more information.

- a curve set for linear dot gain:
  
<table>
<thead>
<tr>
<th>cmyk_LinearColor</th>
</tr>
</thead>
<tbody>
<tr>
<td>cmyk_LinearDensity</td>
</tr>
</tbody>
</table>

contains true linear curves, where 50% prints at 50%,

contains curves for "classic" linear dot gain, where 50% prints at 68%.

Those curves sets are not based on a standard but will give you a good result in most cases (and a dot gain close to most standards).

**Tip:**

If you want to use in-house target curves instead, you should create a custom PressSync curve set template in Curve Pilot. It will appear in this list automatically.

See *Customizing PressSync Templates* in the Curve Pilot documentation for more information.

2. You can see more information about the standard you selected, including:

- a **Description**, listing:
  
  - the substrate,
  - the measurement condition (if applicable),
  - the target curves (specifying the ideal dot gain of the inks)

... used in the standard;

**Note:**

A measurement condition is a setting on some measuring devices that determines the type of light used by the device.

Using the right measurement condition helps correct measurement variations caused by optical brightening agents in newer substrates.

See *Measurement Conditions* in the Curve Pilot documentation for more information.

- the **Print Profile** of the reference press from the standard;
Print Control Wizard

- the **Desired Tone Curves** per separation defined in the standard. **TV50** indicate the desired tone value for the 50% patch. You can also see the metric used to calculate the tone value.

**Note:**
Most standards use one or more reference .dgc curve(s) to specify the ideal dot gain of process inks (measured with **Density ANSI A**), and a linear curve for expanded gamut inks (measured using **SCTV**).

However, when using **cmyk_LinearColor**, the target is linear dot gain (= no dot gain) for all inks (measured using $\Delta E_P$ for process inks and **SCTV** for expanded gamut inks).

Please see **Dot Gain Metrics** in the Curve Pilot documentation for more details on the different metrics that can be used.

### 5.1.7. Ink Set

- In the **Collect Settings - Select Ink Set** step, select the ink set you are printing with.
  
  This can be CMYK or an expanded gamut printing ink set (for example **CMYK Orange Green Violet**), where the expanded gamut inks are part of the **ClassicColors** ink book.

  For more information about expanded gamut printing, please see **Equinox and Expanded Gamut Printing** in the Color Pilot documentation.

### 5.1.8. Ink Settings

In the **Collect Settings - Define Ink Properties** step, enter more information about the inks you are printing with.

1. Select the first ink and click 📊.
2. Enter the **Ink Brand**.
3. Select the **Ink Type** (it can be a **Solvent**, **UV curable** or **Water-based** ink).
4. Enter the ink **Viscosity**.

You can measure an ink's viscosity using an efflux cup. The viscosity is the number of seconds it needs to flow through the hole at the bottom of the cup until the cup is completely empty (very viscous inks need longer).

Some newer press models can measure this automatically (electronically).

**Note:**
The ink's viscosity affects how well it transfers onto your substrate, and can change depending on ambient temperature and time (for example when the solvent in a solvent-based ink starts evaporating).

5. If all the inks in your ink set have the same properties, you can select **Apply properties to all inks**.
6. Otherwise, fill in those properties for each ink in your ink set.

5.1.9. Anilox Settings

In the Collect Settings - Specify Anilox Properties step, enter information about the anilox you are using for each ink.

1. Select the first ink and click 🖍.
2. Enter its anilox Brand.
3. Enter the anilox Type.
4. Enter the anilox' Line Screen in lines per inch (this is the number of cells per linear inch). A higher line screen is used for finer detail, while a lower one will transfer a heavier layer of ink.
5. Enter the Angle of engraving (relative to the anilox axis) in degrees. This is typically 30°, 45° or 60°.
6. Enter the anilox' Cell Volume (the ink capacity of each engraved cell) in billion cubic microns.

Note:
The cell volume of an anilox roll can change over time, due to wear, damage and "plugging" (dried ink residues at the bottom of the cells). Plugging can happen when Solvent or Water-based ink is not cleaned immediately after using the anilox and dries in (UV curable ink will not dry on its own).

7. If all the anilox rolls used for your different inks have the same properties, you can select Apply properties to all inks.
8. Otherwise, fill in anilox properties for each ink in your ink set.

5.1.10. Mounting Tape Settings

In the Collect Settings - Specify Mounting Tape Properties step, enter information about the mounting tape you are using for each ink (to affix your plate to the plate cylinder on your press).

1. Select the first ink and click 🖍.
2. Enter the Tape Brand you use for that ink's plate.
3. Select the Tape Hardness.

The tape can be Soft, Medium or Hard. This is usually indicated on the tape's packaging.

- Hard tape is typically used when working mainly with flat colors and sharp lines.
- Soft tape is mainly used to get smoother tones when printing lots of highlights, shadows, and gradations.
• Medium tape is used for jobs combining flat colors and screened areas. It is also often used when printing flexible packaging materials.
4. If you use the same mounting tape for all your inks' plates, you can select **Apply properties to all inks**.
5. Otherwise, fill in the tape properties for each ink in your ink set.

## 5.2. Linearizing Your Separations

After *collecting your production settings*, it's time to linearize your separations.

The aim of linearization is to make sure your production workflow prints smoothly, without jumps, banding, or inversions.

You do this by printing a sample test job in a single separation and analyzing your print out (see *Making and Analyzing a Print Sample* on page 29).

This gives you the best curve and screen to use for that separation.

• The curve is an adjustment curve that will correct your dot gain to bring it in line with your printing standard.

• The screen will help your production jobs print smoothly (especially in the highlights which is often a problem area).

You can then choose to make and analyze more print samples for your other separations, or use the same curve and screen for all separations (see *Handling the Remaining Separations* on page 46).

The wizard will guide you through linearization in a series of steps whose names start with *Linearize Screen*.

### 5.2.1. Making and Analyzing a Print Sample

To finish fingerprinting your printing setup, you should make a print sample.

Once your sample is printed (with the *exact production settings* you entered in the Print Control Wizard), the wizard will help you analyze it and find the best screen and curve for your production workflow (to *linearize it*).

1. Prepare and print your sample.
   - See *Making a Print Sample* on page 30.

2. Measure your print sample for the wizard to calculate the best curve and screen for this separation.
   - See *Measuring Your Print Sample* on page 33.

3. The wizard suggests the optimal screen to use based on your measurements.
   - We recommend you use the suggested screen, but if you are an expert user, you can choose to see more details and optionally choose another screen.
     - See *Choosing Your Screen* on page 38.

You can then decide whether to copy your chosen screen and the curve found by the wizard to the other separations, or make another print sample (or more) in a different separation.
Making a Print Sample

To assess your production workflow's output, you need to make a print sample. To do this, you will:

- choose the ink to print the sample with,
- make a plate using a test chart (adapted to your flexo printing application),
- print your sample using that ink and plate.

1. In the **Linearize Screen - Select Separation** step:
   a) Click the **Ink** you want to print your sample with.
   b) In the **Screen Technology** column, select the type of screen you want to use.
      - When working with **flexibles**, this is always **Crystal**.
        Crystal screens are tailored to get optimum results when working with the **CDI Crystal imager series** and the **XPS Crystal exposure unit series** devices.
        See **Crystal Screens** for more information.
      - When working with **labels**, you can choose one of the following:
        
        | Crystal NP C (Circular) | ![Crystal NP C example] |
        |-------------------------|------------------------|
        | Crystal NP E (Elliptical) | ![Crystal NP E example] |
        | Crystal NP F (Double Circular) | ![Crystal NP F example] |
        | Crystal NP R (Round Fogra) | ![Crystal NP R example] |
        | Crystal | ![Crystal example] |

      **Note:** **Crystal NP** stands for “Non Pixel+”, as these screens are not specifically designed for working with the CDI Crystal imager series and the XPS Crystal exposure unit series devices.
      See **Screens for Labels** on page 14 for more information.
   c) In the **Ruling** column, select one of the available screen rulings.

These parameters will be used to generate a custom **test chart**, containing different areas where you can measure and compare different settings.
Print Control Wizard

**Note:**
The wizard uses default curves for linear printing when creating the test chart.
After printing this test chart, you will **measure** its actual dot gain, and the wizard will create an adjustment curve to make it match your **printing standard**'s dot gain.

2. In the **Linearize Screen - Save Single Separation Chart** step, save your test chart to a **LEN file** that you can use to make your plate.
   a) Click **Select** and browse to your desired location.
   b) If you want your test chart to be mirrored (for example when printing on a transparent foil), select **Mirrored printing (wrong reading)**.

   **Tip:** In this case, your LEN file name will contain the word **mirrored** (for example **PCW_Flexibles_XPS_Magenta_CWN_150lpi_mirrored.LEN**).

   c) You will see a progress bar while the wizard generates a custom test chart with your required characteristics.

   **Tip:** If desired, you can use the Automation Engine Viewer or the Bitmap viewer to have a look at your LEN test chart.

Here are examples of test charts for **flexibles** and **labels** production workflows:

<table>
<thead>
<tr>
<th>Flexibles</th>
<th>Labels</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Flexibles Chart" /></td>
<td><img src="image" alt="Labels Chart" /></td>
</tr>
</tbody>
</table>

3. **Make a Plate** according to your company's Standard Operating Procedures using this LEN test chart.
Important:

- Make sure to use the exact *imager*, *exposure* and *plate* settings you defined earlier!
- Following your Standard Operating Procedures ensures that the plate is representative of the way you typically make plates.

4. Inspect your plate to make sure it meets your quality standards (as you need a good quality print sample to get good results with the Print Control Wizard).

   We recommend you use a magnifier (of 12x magnification factor or more). If desired, you can also inspect the basic patches and patterns at the top right of the plate.

5. **Make a Print** using this plate and your chosen ink, according to your company's Standard Operating Procedures.
Important:

- Make sure to use the press and substrate settings you defined earlier!
  This is important as the Print Control Wizard will generate a screen and curve optimized to your specific substrate, ink (and viscosity), printing speed...
- Following your Standard Operating Procedures ensures that the print is representative of the way you work.

6. Inspect your print to make sure it meets your quality standards (you need a good quality print sample to get good results with the Print Control Wizard).

   We recommend you use a light booth and a magnifier (of 12x magnification factor or more).

   You can now start measuring your print sample.

Measuring Your Print Sample

You now need to measure your print sample so that the Print Control Wizard can derive the best screen and curve to use for this separation in your production workflow.

You need a spectrophotometer for this step. The Print Control Wizard supports the X-Rite i1 and i1iO spectrophotometers.

1. Get ready to measure your print sample:
   a) Place your sample on your spectrophotometer table or on the backing you typically use for measuring prints.
   b) Make sure your spectrophotometer is connected to your computer and click Connect or Reconnect if needed.

2. In the Linearize Screen - Measure Gradations step, measure your gradation patches.
   See Measuring the Gradation Patches on page 33 for details.

3. In the Linearize Screen - Measure Mindot step, measure your mindot strips.
   See Measuring the Mindot Strips on page 36 for details.

Note:

To ensure your measurements are representative of the way you print, we recommend you perform several measurements, both of the gradation patches and the mindot strips, preferably using different print samples.

If you are using a large plate size that can fit your test chart several times, we also recommend you place it on several locations on your plate and measure all these locations on your printed sample.

Measuring the Gradation Patches

You first need to measure the randomized gradation patches from your LEN file print out.
Once the wizard knows how a gradation prints with your production workflow, it will be able to calculate a good adjustment curve for your dot gain.

1. In the **Linearize Screen - Measure Gradations** step, you can see:
   - the **Layout** of your gradation patches,

   **Note:**
   
   By default, this ToneScaleControlStrip_Random.it8 (the gradation patches layout used in the LEN file that the wizard generated). We recommend you use this.

   However, if you want to measure a custom gradation strip instead, you can do the following:

   1. Make sure you have a layout of your custom gradation strip in the CGATS (.it8) format.
   2. Save this layout to the following folder: `C:\Esko\bg_prog_intellicurve_v180\dat\Resources\templates` (or use the relevant drive letter if you didn't install the Print Control Wizard on the C:/ drive).
   3. In the Print Control Wizard's **Linearize Screen - Measure Gradations** step, select your custom gradation strip layout in the **Layout** list.
   4. Measure a print out of your custom gradation strip as explained below.

   - a preview of the gradation patches in *your chosen separation*.
Print Control Wizard

Note:
The default gradation patches layout is randomized, which means that gradation patches are "scrambled" instead of being printed in a classic gradation strip order.

This helps balancing your press' printing variations (for example left to right printing differences, or "color jumps" near the line endings), so that they don't wrongly influence the adjustment curve that will be calculated.

The randomized area contains the patches of 3 gradation strips.

2. Click **Start** and follow the instructions on screen to measure the gradation patches.

You can **Pause** or **Stop** the measurement if needed.

Tip:
If your gradation patches were already measured in the press room, click **Load measurement...** and browse to the measurement file they sent you.

This should be a GCATS measurement file (in the .it8 format).

If desired, you can save a measurement to a file using **Save Measurement...**.

3. You can see the measured patches displayed on screen, and additional information at right.
   a) Hover on individual patches to view their **Desired** values (based on the printing standard you chose), **Measured** values, and the **ΔE** between the two.

   ΔE is a unit of difference between colors, based on the colors' Lab values.

   The more different two colors are, the higher the Delta E number is. Generally a human eye can perceive color differences that are above 2 Delta E.

   You can see the **Desired** and **Measured Lab** values, **Density**, and the relevant dot gain metrics (from your chosen printing standard).

   Where the **Desired** and **Measured** values are different, you can see split patches in the preview (with the desired color at the top left, and the measured color at the bottom right).

   b) You can also see the **Measurement Condition** set on your spectrophotometer, and the **Metric Preferences** set in your chosen standard.
A measurement condition is a setting on some measuring devices that determines the type of light used by the device.

Using the right measurement condition helps correct measurement variations caused by optical brightening agents in newer substrates.

See *Measurement Conditions* in the Curve Pilot documentation for more information.

**Note:**

If *your chosen printing standard* specifies a measurement condition, the Print Control Wizard switches your spectrophotometer to this measurement condition automatically.

In case you are using a spectrophotometer that doesn’t support the measurement condition from your standard, you will see a warning and your device will use a measurement condition it does support.

For example if you have chosen to work with the *cmyk_FOGRA51* standard (that specifies M1), but you are using an older spectrophotometer that only supports M0, it will use M0.

4. We recommend you make several measurements (from the start, middle and end of your press run, and if possible even from different press runs at different times of the day and/or in different places on your sheet) to capture your press variation.

The Print Control Wizard will average all your measurements to calculate an adjustment curve that is better suited to how your press prints at different times.

**Measuring the Mindot Strips**

You then need to measure the mindot strips from your LEN file print out.

"Mindot" stands for minimum dot, and the strips you will measure contain different possible minimum dots for your *screening technology*.

- When working with *flexibles* and an *XPS device*, the strips use the *Crystal and Crystal C screens*.

- When working with flexibles and an *External or Inline-UV device*, the strips use the Crystal C screen.

- When working with *labels*, the strips use *your chosen screening technology*.

You can see the name of the corresponding screen next to each strip to measure (for more information about screen names, see *Screen Name*).
After you measure the strips, the wizard will help you choose the best minimum dot in your print sample, and calculate the best screen for your production workflow.

1. In the **Linearize Screen - Measure Mindot** step, you can see:
   - the **Layout** of the mindot strips (on the **LEN file** that the wizard generated),
   - a preview of the mindot strips in your chosen separation.
   - If you are working with **flexibles**, the mindot strips look like this:
• If you are working with *labels*, the mindot strips look like this:

![Mindot strips example](image)

2. Click **Start** and follow the instructions on screen to measure the mindot strips. You can **Pause** or **Stop** the measurement if needed.

   **Tip:**
   If your mindot strips were already measured in the press room, click **Load Measurement**... and browse to the measurement file they sent you.
   This should be a GCATS measurement file (in the .it8 format).

   If desired, you can save a measurement to a file using **Save Measurement**....

3. You can see the measured patches displayed on screen.

4. We recommend you make several measurements (from the start, middle and end of your press run, and if possible even from different press runs at different times of the day and/or in different places on your sheet) to capture your press variation.

   The Print Control Wizard will average all your measurements to calculate a screen that is better suited to how your press prints at different times.

**Choosing Your Screen**

In the **Linearize Screen - Select the Optimal Screen** step, the wizard displays the best screen(s) it found for your production workflow, and their minimum dots characteristics.

Any of those screens will give you a good quality print (based on your mindot strips measurements), but you should select the most optimal one (typically, this is the one that can produce the lightest tones for your highlights).

1. Check the screen(s) recommended by the wizard.

   For each recommended screen, you can see:
   - the **Screen Name**,
   - the **Minimum Dot on Plate**,
   - the **FM Dot Population**,
   - the **Lightest Tone Value**.

   **Screen Name**
The screen name (for example **Crystal S3R2 9** or **Crystal NP C 4**) indicates some of the screen's main characteristics:

- the screen technology used; this depends on your *flexo printing application* and the screen technology you chose when *making your print sample*:
  - when working with flexibles, it can be **Crystal** or **Crystal C**,
  - when working with labels, it can be **Crystal NP C**, **Crystal NP E**, **Crystal NP F**, **Crystal NP R**, **Crystal** or **Crystal C**.

See *Screens for Flexibles* and *Screens for Labels* for more information.

- the support dot characteristics (for example **S3R2**); this includes:
  - the size of the support dot (**S3** = 3 pixels)
  - the type of ruling used (**R1** = single ruling, **R2** = double ruling)

This part of the name is not shown if the screen does not include support dots.

- the number of pixels of the minimum dot (**9** = 9 pixels).

Those characteristics have been assessed by the wizard when measuring the LEN file's *mindot strips*.

**Minimum Dot on Plate**

The minimum dot on plate in microns is the diameter of the minimum dot that prints in a stable way.

**FM Dot Population**

The FM dot population indicates the amount of dots used to print the highlights.

<table>
<thead>
<tr>
<th>1/1 means that all the dots are kept (the screen doesn't use FM screening)</th>
<th>1/2 means that half of the dots are kept (resulting in FM screening)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Minimum Dot on Plate" /></td>
<td><img src="image" alt="FM Dot Population" /></td>
</tr>
</tbody>
</table>
1/4 means that a quarter of the dots are kept (resulting in FM screening)
A lower FM dot population gives lighter highlights, but may increase graininess.

The FM dot population indicated for a screen is the one the screen transitions to in its lightest highlights.

If you see 1/4, it means that the screen gradually transitions from 1/1 (no FM) to 1/2, then to 1/4 in the highlights, as you can see below.
Lightest Tone Value
This is the lightest tone value that you can achieve with the minimum stable dot (Minimum Dot on Plate).

2. Based on this information, choose to use either:
   - (one of) the recommended screen(s). See Choosing (One of) the Recommended Screen(s) on page 41.
   - a different screen (you will need to inspect screens manually). See Choosing Another Screen Manually on page 41.

**Note:**
You can do this in case you are not satisfied with any of the suggested screens, and want to choose a different screen based on your print sample.
However, this is a complex assessment requiring in-depth technical knowledge, so we recommend you don't do this unless you are an expert user.

Choosing (One of) the Recommended Screen(s)
You can see a green check next to the screen that gives you the lightest tone value. This is the screen that the Print Control Wizard recommends as the optimal screen.

It is selected by default.

**Note:** We recommend you select one of the recommended screens. However, if you are an expert user, you can also choose another screen manually.

- If you are satisfied with the screen selected by default:
  a) Make sure that the **Accept the selected screen as the optimal screen** option is selected.
  b) Click **Next**.
- If you want to use another screen from the list of suggested screens:
  a) Click your desired screen.
  b) Make sure that **Accept the selected screen as the optimal screen** is selected.
  c) Click **Next**.

After selecting your screen, we recommend that you check its highlights visually on your print sample. See Inspecting Your Screen's Highlights on page 44.

Choosing Another Screen Manually
If you are not satisfied with any of the recommended screens and want to choose a screen manually, select **Inspect the screens and choose the optimal screen later (one extra step per screen)** and click **Next**.

**Attention:** This is a complex assessment requiring in-depth technical knowledge, so we recommend you don't do this unless you are an expert user.

To choose a screen manually, you need to inspect the **mindot strips** on your print sample.
• When working with flexibles, the mindot strips look like this:

![Mindot Strip Diagram for Flexibles]

• When working with labels, they look like this:

![Mindot Strip Diagram for Labels]

There is one strip per screen (that is, per variant of the screening technology used to print the sample).

The Print Control Wizard will show you an analysis of the values you measured for each screen/strip (in a separate wizard step per screen), starting with the (top) left strip.

1. In the first **Linearize Screen - Find the Minimum Tone for (Your Separation Name)** step, the wizard shows you a detailed result of your measurements for the first screen/strip.

![Measurement Table]

The patches on screen are arranged as in your print sample, by minimum dot size (horizontally) and **FM dot population** (vertically).
For each patch, you can see the tone value produced by the screen used in this patch, and the wizards' evaluation:

- the patch with a green check 🟢 is the one the wizard considers optimal: it prints in a stable way and produces the lightest highlights of all the stable patches,
- patches with no specific markings also print in a stable way,
- patches with a red cross ❌ do not guarantee a stable print (you can hover on a specific patch to see more information),
- greyed out patches cannot produce a stable print (for example a minimum dot of 1 pixel is too small to be a reliably printable dot).

**Tip:** A stable print gives a smooth result without any clumping or missing dots.

2. Locate the strip printed with the first screen on your print sample and inspect it on a light booth with your magnifier.

3. If:

- you agree with the wizard's evaluation for this screen, just click **Next**,
- you think another patch is better than the one the wizard considered optimal, select your preferred patch in the wizard and click **Next**.

**Note:**
You can select any patch except the greyed out ones.

For example in some cases you may want to select a patch with a higher tone value but that gives a more stable print, or a patch that gives a slightly less stable print but a lower tone value.

- you are not happy with any of this screen's patches on your print sample, select **Reject all patches** and click **Next**.
4. Do this for all the other screens/strips in your print sample.
5. Once you have evaluated all the strips, the wizard will list the screens you chose in the **Linearize Screen - Select the Optimal Screen** step.

   For each of the screens, you can see:
   - the **Screen Name**,  
   - the **Minimum Dot on Plate**,  
   - the **FM Dot Population**,  
   - the **Lightest Tone Value**.

   You can see a green check ✔ next to the screen that gives you the lightest tone value. This is the screen that the Print Control Wizard recommends as the optimal screen for printing highlights.

6. If:
   - you want to use the screen that gives you the lightest tone value, just click **Next**.  
   - you want to use another one of your chosen screens, select it and click **Next**.

   If needed, you can also go **Back** to evaluate the screens again.

After selecting your screen, we recommend that you check its highlights visually on your print sample. See **Inspecting Your Screen's Highlights** on page 44.

**Inspecting Your Screen's Highlights**

The **Linearize Screen - Visual Inspection of the Screen for [Your Separation]** step will help you check the highlights of your selected screen visually on your print sample.

1. At the bottom of your print sample, locate the **HIGHLIGHT CHECK B** area, and look for the column corresponding to your selected screen.
This column shows what the screen’s highlights (in the 0% to 5% range) look like when using:

- different *FM Dot Populations* (**HIGHLIGHT 1/1**, **HIGHLIGHT 1/2** and **HIGHLIGHT 1/4**),
- different *numbers of pixels* for the minimum dot (for example 3, 4, 5, 6... depending on your screening technology).

2. In the Print Control Wizard, your selected screen (with its FM Dot Population and number of pixels for the minimum dot) is highlighted.
Locate that same area on your print sample, and inspect it on a light booth using a magnifier.

The highlights gradient should fade smoothly, as in the A gradient below.

If you encounter any of the following issues, the highlights quality is not good enough:

• B: the screen prints too dark, giving a hard edge in the highlights,
• C: there is tone reversal in the highlights,
• D: the print is too grainy.

In this case, inspect the neighboring highlight gradients (within the same or another FM Dot Population) to try and find better quality highlights.

If you don't find any satisfactory highlights for your selected screen technology, inspect the highlights of another screen technology (for example Crystal C instead of Crystal).

3. If you have found a highlight gradient on your print sample that you consider better than the one selected in the wizard, you can select that one instead:
   a) Select the Modify check box above the highlights gradients.
   b) If needed, select a different screen technology in the list.
   c) Select the highlight gradient that you found to be the best.
   d) Click Next.

Otherwise, just click Next.

4. The wizard generates your chosen screen (with its particular screen technology, FM Dot Population and number of pixels for the minimum dot), together with a custom adjustment curve based on your gradation measurements.

Attention: You cannot use any screen while the wizard does this. This also means that you cannot use Imagine Engine's Image to Screened Separations task. This may last several minutes.

5.2.2. Handling the Remaining Separations

Once the wizard calculated the best curve and screen for the separation you used to print a sample, you need to decide what to do for the remaining separations.

In the Linearize Screen - Screen Linearization Was Done Successfully step, you can see the Screen and Adjustment Curve that the wizard calculated for your sample's separation.
Note:
The adjustment curve is a flexible PressSync curve. This is a PressSync curve with additional options for greater control in the highlights and shadows (such as a minimum dot, and specific curve shapes in the highlights and shadows).
See Flexible PressSync Curves on page 9 for more information.

• Under Do you want to linearize another ink?, select either:
  • Yes, I want to start a linearization cycle for another ink to print a sample using another separation, measure it, and have the wizard calculate a screen and curve for it.
  • No, I finished linearizing individual inks. I want to copy the screens and curves found to the remaining inks to copy the screen and curve from your sample's separation to the other separations.
    • If you only linearized one separation, the wizard will copy its screen and curve to the other ones.
    • If you already linearized two or more separations, do the following in the Linearize Screen - Copy screens and curves step:
      1. select the ink you want to copy screens and curves to,
      2. in the Copy Screen and Curve from column, select the ink whose screen and curve you want to copy,
      3. do this for every remaining ink.

5.3. Resulting Screens and Curves

When you have a screen and curve for every separation, you can see them displayed in the Report step: you can see the Screen Technology and Ruling used, and the Screen and Adjustment Curve calculated by the wizard for each separation.

You can also see the name of the PressSync Curve Set that the Print Control Wizard created for your Printing Condition. This PressSync curve set contains the curve(s) for all your separations.

Click Save and Quit to finish creating your printing condition and close the wizard.

You can see your printing condition in the Print Control Wizard window with a green check ✔ indicating that you have completed it.

You can still view its details if desired by clicking (but you cannot edit it anymore once it is complete).

Note:
If you make changes to your production workflow (for example you print on a different substrate, or you switch to a different ink vendor), we recommend you make another printing condition to get adapted screens and curves.

You can duplicate your existing printing condition (so that you only need to change a few settings instead of filling everything in), then make a new printing sample and measure it.
6. Using Your Printing Condition in Imaging Engine

Once the Print Control Wizard created a printing condition containing the optimal screen(s) and curve(s) to use for your production workflow, you can use this printing condition when RIP'ing your files with Imaging Engine.

To do this, open Imaging Engine's Image to Screened Separations ticket and select your printing condition in the Printing Condition field (above the other settings).

**Note:**

- You can only use a printing condition that you have **completed** (you can see a green check ✓ in the Print Control Wizard).
  
  If you are still working on your printing condition in the Print Control Wizard, you will not be able to select it in Imaging Engine yet.

- After making a printing condition for your production workflow, you should always use it in Imaging Engine when printing with that production workflow.
  
  If you make changes to your workflow (for example you print on a different substrate, or you switch to a different ink vendor), we recommend you make a new printing condition in the Print Control Wizard.

Selecting a printing condition automatically fills in the relevant Image to Screened Separations settings, so that the task uses the screen(s) and curve(s) calculated by the Print Control Wizard, and the ruling used to make your print sample.

Please see the Imaging Engine documentation for more details.
### 7. Managing Your Printing Conditions

On the first screen of the Print Control Wizard application (the screen you see before opening the Create Printing Condition wizard), you can see the state of your printing condition(s) (how far along you are in creating a printing condition). See *Printing Condition States* on page 50.

You can also manage your printing conditions:

<table>
<thead>
<tr>
<th>You can:</th>
<th>by either:</th>
</tr>
</thead>
<tbody>
<tr>
<td>delete a printing condition</td>
<td>• clicking [Delete]  &lt;br&gt; • right-clicking and selecting <strong>Delete</strong>  &lt;br&gt; • going to <strong>File &gt; Delete</strong></td>
</tr>
<tr>
<td>edit a printing condition</td>
<td>• double-clicking it  &lt;br&gt; • clicking [Edit]  &lt;br&gt; • right-clicking and selecting <strong>Edit</strong>  &lt;br&gt; • going to <strong>File &gt; Edit</strong></td>
</tr>
<tr>
<td></td>
<td>This opens your printing condition at the point you last saved it.  &lt;br&gt; After completing a printing condition, you cannot edit it anymore.</td>
</tr>
<tr>
<td>duplicate a printing condition</td>
<td>• clicking [Duplicate]  &lt;br&gt; • right-clicking and selecting <strong>Duplicate</strong>  &lt;br&gt; • going to <strong>File &gt; Duplicate</strong></td>
</tr>
<tr>
<td>export a printing condition, or import one you made elsewhere</td>
<td>• right-clicking and selecting <strong>Import</strong> or <strong>Export</strong>  &lt;br&gt; • going to <strong>File &gt; Import</strong> or <strong>Export</strong></td>
</tr>
</tbody>
</table>

See *Importing and Exporting Printing Conditions* on page 51 for more information.


### Note:

- If you made a printing condition then later changed some of your production settings (for example to use a different substrate), we recommend you duplicate your original printing condition, then change the relevant setting(s) in the duplicate and make a new print sample. This way you can make a new accurate printing condition without needing to re-enter all your production settings in the wizard.

- If you upgraded your Print Control Wizard application to a newer version, and you still have an unfinished printing condition from the older version, you can still edit it in the new version. However, some settings may have changed (some older settings may not be available anymore, and there may be new settings), so we recommend you first duplicate your old unfinished printing condition, then edit the duplicate.

### 7.1. Printing Condition States

On the first screen of the Print Control Wizard application (the screen you see before opening the **Create Printing Condition** wizard), you can see an status icon indicating how far along you are in creating your printing condition.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>■■■■</td>
<td>You have <em>created</em> your printing condition but still need to fill in (some of) your production settings.</td>
<td>Collecting Your Production Settings on page 21.</td>
</tr>
<tr>
<td>■■■■</td>
<td>You have filled in all the necessary production settings and now need to linearize at least one separation.</td>
<td>Linearizing Your Separations on page 29.</td>
</tr>
<tr>
<td>■■■■</td>
<td>You have made a plate from your test chart and are in the process of printing your chart (see <strong>Making a Print Sample</strong> on page 30). When your print sample is ready, you can start measuring it.</td>
<td>Measuring Your Print Sample on page 33.</td>
</tr>
<tr>
<td>■■■■</td>
<td>You are measuring your print sample.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>After measuring, the Print Control Wizard will calculate the best screen(s) and curve for you to use. See <strong>Choosing Your Screen</strong> on page 38 and <strong>Resulting Screens and Curves</strong> on page 47.</td>
<td></td>
</tr>
<tr>
<td>✔</td>
<td>You have a screen and curve for every separation, your printing condition is complete. You can start using it in production.</td>
<td>Using Your Printing Condition in Imaging Engine on page 48.</td>
</tr>
</tbody>
</table>
7.2. Importing and Exporting Printing Conditions

If you are working with several sites that don’t use the same curves database, and you want to standardize your printing using the printing condition you created, you can export it then import it at another site.

You can either export and import a completed printing condition to use it as is, or a export/import a printing condition in progress (for example if you use the same printing setup but want to measure a printing sample at each site).

• To export a printing condition:
  a) In the initial Print Control Wizard window, select the printing condition to export and go to File > Export (you can also right-click it and select Export).
  b) Browse to the location you want to export it to, change the File name to use if desired, and click Save.

The printing condition is exported as a File Packer archive (*.fp). This archive contains all of your printing condition’s information (including measurements, screens and curves if it had them).

• To import a printing condition:
  a) In the initial Print Control Wizard window, go to File > Import (or right-click in the window and select Import).
  b) Browse to the exported *.fp archive containing the printing condition you exported and click Open.

The printing condition is imported exactly as it was before the export. If you already had a printing condition with the same name, the name of the imported one will end with _ (1).